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New Data Warehouse Items

2002 Recurrence Reports

The CPS unit code has been added to the list of all children so that users can then sort the report by unit. We have
also added a Recurrence Flag to the child specific report, highlighting which CPS report is the ‘recurrence’ report.
Footnotes are now on every page. We hope these enhancements provide some additional utility to the reports. The
report write-up has also been updated.

Click here for detailed information

Featured Report

This featured report is the CPS Reports Processed During the Period.

Purpose: To provide CPS Managers and Supervisors with the ability to view and / or report upon case workloads, the
status of Intakes and Investigations, the volume of reports processed, and the flow of reports as they go through the
investigatory process at the Unit and Worker levels. These reports can serve as a tool for monitoring and managing
caseloads.

Click here to see a sample of the report

Click here to read a detailed explanation of the report

Tips and Tricks

Saving and Printing Reports

Users frequently contact us for assistance pertaining to the saving and printing documents from the Data Warehouse.
The attached documentation will provide you with the necessary steps to save and print your documents.

Click here for more information on saving and printing reports




Frequently Asked Questions

Question: I've lost the page Layout view in Impromptu

ANSWER: This occurs when CITRIX fails to recognize and assign your local printer as the default printer within the
CITRIX session. To correct this, exit Impromptu, but do not exit your CITRIX session. At the CITRIX
desktop, click START/SETTINGS/PRINTERS and confirm that your local client printer is the default
printer. If there is not a checkmark by it, highlight the printer and click File/Set as Default Printer from the
toolbar menu. You should now be able to enter Impromptu and have the Page Layout view available to
you.

Question: The Impromptu report that | printed came out looking like a postage stamp

ANSWER: This occurs when trying to print an Impromptu report from within the CITRIX environment. (To reduce
network load and traffic, we have disabled the ability to print from within the CITRIX environment.) To
print your Impromptu report you must first save it as an Acrobat (.pdf) or Excel with Format (.xIs) file to
your T drive while in your CITRIX session. Then exit CITRIX and open the .pdf or .xIs file from your NT
environment and print it. For further information regarding saving Impromptu reports to different formats,
please refer to your Step-By-Step manual.

Data Warehouse User Training Schedule

Below you will find a link to the Connections Web Page. Once there, click on the OCFS Data Warehouse, which is
located towards the bottom left hand side of the page. Listed on the bottom of OCFS Data Warehouse Web Page is
the latest version of the Training Schedule for Data Warehouse and Advanced Data Warehouse for the third
quarter.

http://sdssnet5/ocfs/connect/default.htm

Contact Us

On behalf of the OCFS Data Warehouse Team, we would like to thank you for your on-going support and participation. In
the up and coming months we are planning to implement many more new reports and Data Warehouse improvements
which will be announced as they occur. If you have any questions, issues or concerns feel free to contact Joe De Lucia at
(518) 473-8209 or send him a message at Joe.Delucia@dfa.state.ny.us.



http://sdssnet5/ocfs/connect/default.htm

Recurrence of Maltreatment

Background of the Reports

These three reports identify children who are part of the recurrence data indicator as
defined by ACF’s Children’s Bureau. The recurrence data are part of the state Child and
Family Services Review (CFSR) data profile. During the on-site case readings all
applicable cases were rated as ‘substantially achieved’. However, New York State was
found not to be in substantial conformity on Safety Outcome S1 because our data did not
meet the national standard for this data indicator. The national standard is 6.1% and New
York’s rate is 13.5%, per the official Data Profile using 1999 NCANDS data.

Purpose of the Reports

OCFS is, through its PIP (Program Improvement Plan), identifying policy, programmatic
and practice steps to be taken to reduce this ratio. This series of Recurrence Reports is
intended to help identify potential systemic factors contributing to the recurrence of these
children by looking at the allegations in the multiple reports. Are the same allegations
continuing to be reported? Because child level information is also provided, reviewing
other dynamics on a case-by-case basis is possible. Only key pieces of information are
presented. Details of the CPS reports are available in CONNECTIONS and/or the local
case records.

Reports Descriptions

The recurrence of maltreatment data indicator is derived from our NCANDS submission.
The following definition is used by the Children’s Bureau for recurrence of maltreatment:
The universe (or base population) is a count of unique (distinct) children with a
substantiated allegation in an indicated report that was reported in the first six months of
the year. From that population a child is counted as an instance of ‘recurrence’ if the
child has another substantiated allegation in an indicated report and the date of the second
oral report is within 2 to 183 days of the oral report of the first report.

There are now three recurrence-related reports in the Data Warehouse.

CFSR 2000 Recurrence by District — This report lists the recurrence rate for each
district. Since the report displays aggregate numbers, it can be viewed by all users who
have access to the OCFS Data Warehouse. Numbers for the numerator and denominator
for the rate calculation are displayed as well as the recurrence rate itself.



Districts can drill down to their child specific data by double-clicking on the column
labeled ‘County Code’ or by clicking once on the desired county code and then clicking
once on the Drill Through symbol on the tool bar. At this point, security rules are applied
so that districts can see only their own data. Voluntary agencies cannot drill through.

FDF
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Recurrence by District 2000, pdf

CFSR 2000 District Specific Recurrence Summary — This report lists the children who
comprise the recurrence calculation. In the column labeled ‘Recurrence’ a child who
meets the criteria for recurrence has the word ‘Yes’ as an entry. Children who are only in
the base population and did not have a second report have no entry in that column. The
child’s Person Id from CONNECTIONS is displayed along with the child’s name and the
associated unit code.
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Districts can then drill down to get some report level data. These are the reports that met
the criteria for the recurrence definition and the relevant reports for this child plus any
other report that the child was a member of in the NCANDS submission. For example,
the child may be part of another indicated report but does not have substantiated
allegations in this report. In that case, there will be blanks in the Substantiated
Allegations columns. Double-click on the column labeled ‘Child PID’ or click once on
the desired county code and then click once on the Drill Through symbol on the tool bar.
At this point, security rules are applied so that districts can see only their own data
Voluntary agencies cannot drill through.

CFSR 2000 Recurrence Indicated Reports Detail — This reports lists key pieces of
information so that further analysis can be done. The CONNECTIONS Case ID and
Report ID, which is the Investigation Stage ID, are listed to get more detailed information
via CONNECTIONS. The Recur Flag identifies which report actually caused the child to
meet the criteria of recurrence. Intake Stage Start Date (date of the oral report) and
Investigation Stage Close Date (date of the determination) are listed to provide some time
parameters. And, the Substantiated Allegations are shown so that users can begin to see
what allegations have been substantiated for this child.

FOF
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Recurrence of Abuse/Neglect Based on Federal Definition*

from NCANDS Submission ( Indications in 2000 )
( National Standard 6.1% , Safety Outcome 1)

Date: 7/9/2003

District Code District Name Children with Recurrence Children in Rate
Indicated Reports

001 ALBANY 177 685 25.8
002 ALLEGANY 11 87 12.6
003 BROOME 44 350 12.6
004 CATTARAUGUS 59 230 25.7
005 CAYUGA 11 99 11.1
006 CHAUTAUQUA 118 534 22.1
007 CHEMUNG 146 584 25.0
008 CHENANGO 18 143 12.6
009 CLINTON 67 307 21.8
010 COLUMBIA 41 223 18.4
01l CORTLAND 42 186 22.6
012 DELAWARE 43 167 25.7
013 DUTCHESS 79 650 12.2
014 ERIE 184 1,588 11.6
015 ESSEX 6 47 12.8
016 FRANKLIN 24 123 19.5
017 FULTON 45 174 25.9
018 GENESEE 26 150 17.3
019 GREENE 26 82 31.7
020 HAMILTON 0 4 0.0
02t HERKIMER 21 155 13.5
022 JEFFERSON 44 338 13.0
023 LEWIS 5 50 10.0
024 LIVINGSTON 24 116 20.7
025 MADISON 38 185 20.5
026 MONROE 127 1,134 11.2
027 MONTGOMERY 22 129 17.1
028 NASSAU 90 846 10.6
029 NIAGARA 52 279 18.6
030 ONEIDA 74 516 14.3
031 ONONDAGA 120 1,003 12.0
032 ONTARIO 45 249 18.1
033 ORANGE 88 494 17.8
034 ORLEANS 11 69 15.9
035 OSWEGO 64 491 13.0
036 OTSEGO 28 171 16.4
037 PUTNAM 12 54 22.2
038 RENSSELAER 18 142 12.7

* Federal Definition : The universe (or base population) is a count of unique (distinct) children with a substantiated
allegation in an indicated report that was reported in the first six months of the year. From that population a child is
counted as an instance of 'recurrence’ if the child has another substantiated allegation in an indicated report and the
date of the second oral report is within 2 to 183 days of the oral report of the first report.
**State Total is a unique count of children. It does not equal the sum of the individual counties since a child may
appear in more than one county.
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?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"001","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"002","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"003","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"004","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"005","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"006","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"007","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"008","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"009","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"010","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"011","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"012","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"013","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"014","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"015","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"016","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"017","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"018","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"019","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"020","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"021","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"022","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"023","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"024","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"025","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"026","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"027","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"028","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"029","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"030","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"031","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"032","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"033","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"034","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"035","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"036","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"037","Report%20Year	00000000,00000000"%20%3D%20"2000"]
?IU=IMRAP&CD=Drill&E=recurrence_summary&DID=&FT=["County%20Cd	00000000,00000000"%20%3D%20"038","Report%20Year	00000000,00000000"%20%3D%20"2000"]

Children in Recurrence Population From NCANDS Submission

( Indications in 2001 )

Date: 6/27/2003

for HUDSON
Recurrence | Child PID Child Name Unit*

YES| 78067198|Ross, Tiffany 002
YES|: 78479013|Alston, Hope 002
YES| 79629276|Mitchell, Brandi (002
YES|: 79857202|Fletcher, Lucas 002
YES| = 93685601|Evans, Eric 002
YES|  93689988|Fletcher, Daniel |002
YES|  97722604|Mitchell, Melissa {002
YES|  78467617|Harding, Keith 003
YES| 78467618 Harding, Nija 003
YES|  78151709/Harding, Malia 005
YES| = 785334 14|Mitchell, Michael |005
YES| 78894004|Harding, Malik 005
YES| 78942587 Kennedy, Makayla [005
YES|[  91908572Mitchell, Janet 005
YES| 95646151|Doe, Tiffany 005
YES|  768083816|Ross, Luke 006
YES|  77481745|Ross, Gregory 006
YES| 78137117 |Ross, Selena 006
YES|: 78417891|Warner, Kayla 006
YES| = 78704286|Child Merged 006
YES|: 79389368|Evans, Raqwane [006
YES|  91749205/Barnham, Quashar|006
YES|  91902145/Warner, Gamein |006
YES|: 91934327|Jessup, Adam 006
YES|: : 91945524|Evans, Damon 006
YES|  93800397|Evans, Rakeem |006
YES|  93806206|Spencer, Anajah |006
YES|: Z7708975|Coverdale, Angela [160
YES|  91551470|Spencer, Joshua [160
YES| 93860486|Peters, Craig 160

76548436|Doe, Joseph 002

76572198/ Harding, Lindsey (002

76572206|Harding, William 002

16773149|Peters, Amber 002

16773689 Peters, Guy 002

16773690|Peters, Brittney 002

76845318/ Warner, Breanna (002

For the years 1999 through 2001, if there was a Person Merge after the investigation closing, we do not have the
merged Person Id to extract the Child's Name. For these children, the Name field is "Child Merged". This
limitation was corrected for the year 2002.

Unit* : In most cases, the in-assigned unit of the report's original primay worker

Confidential Data
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?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"78067198"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"1999","Child%20Id	00000000,00000000"%20%3D%20"78479013"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"79629276"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"79857202"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"93685601"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"93689988"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"97722604"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"78467617"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"78467618"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"78151709"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"78533414"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"78894004"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"78942587"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"91908572"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"95646151"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"76808816"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"77481745"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"78137117"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"78417891"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"78704286"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"79389368"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"91749205"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"91902145"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"91934327"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"91945524"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"93800397"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"93806206"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"77708975"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2000","Child%20Id	00000000,00000000"%20%3D%20"91551470"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"1999","Child%20Id	00000000,00000000"%20%3D%20"93860486"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"76548436"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"76572198"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"76572206"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"76773149"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"76773689"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"76773690"]
?IU=IMRAP&CD=Drill&E=recurrence_detail&DID=&FT=["Report%20Year	00000000,00000000"%20%3D%20"2001","Child%20Id	00000000,00000000"%20%3D%20"76845318"]

Indicated Reports with Recurrence from NCANDS Submission (Indications in 2000)

for Child ID: 78704286

Date: 6/27/2003

County| CaseID | Report | Recur| Intake Start |Investigation| Substantiated Allegation 1 | Sub Allegation 2 Sub Allegation 3 | Sub Allegation 4
ID Flag Date Close Date
090 79384576[ 79030055|Yes  |3/22/2000 8/2/2000 Neglect/Deprivation of Necessi
79188915 10/18/1999 6/27/2000 Neglect/Deprivation of Necessi

For the years 1999 through 2001, if there was a Person Merge after the investigation closing, we do not have the merged Person Id to extract the
Child's Name. For these children, the name will not appear. This limitation was corrected for the year 2002.

Confidential Data
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Date Of This Report: 7/2/2003
Connections Data As Of: Connections Data As Of Date

CPS Reports Processed During the Period
Period Covered: 2001

Statewide Layer 6 of 6
Total CPS | Total CPS Total CPS Total New | Total Initial Total Total CPS | Total CPS | Total CPS Total CPS
Reports Reports Reports CPS Reports CPS Subsequent Reports Reports Reports Reports
Active in Active at | Active at End| Assigned Reports CPS Reports | Overdue on | Indicated | Unfounded | Opened for
This Period | Beginning of |  of Period This Period Assigned Assigned Last Day of Service in this
Period This Period | This Period Period Period
New York City 65,355 8,600 9,126 56,755 43,195 13,560 813 19,312 37,095 12,264
Regional Offices 1,712 399 461 1,313 1,282 31 292 181 1,070 0
State Offices 35 23 26 12 10 2 22 3 6 0
Statewide Agencies 407 161 163 246 242 4 124 13 231 0
Upstate 120,634 24,621 27,748 96,013 71,356 24,657 15,065 27,563 65,523 12,858
Totals 188,143 33,804 37,524 154,339 116,085 38,254 16,316 47,072 103,925 25,122
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Appendix B4:
Investigation Reports—
CPS Reports Processed During the Period Statewide Totals

Report Title: CPS Reports Processed During the Period

Report Purpose: To provide CPS Supervisors and Managers with information on
the status of Intakes and Investigations that comprise the
workloads of the staff and units that they supervise.

Totals: Number of CPS Reports that were processed during the period
covered by location of primary worker. Statewide Total reports
include totals by Upstate, New York City, Other Agencies,
Statewide Agencies, and Regional Offices.

Layers: Statewide — Upstate/Downstate, Region, County, Unit, Worker,
and CPS Report

Other Dimensions

Available: Date
NCANDS Reporter Type

Other Measures

Available: See Data Items below.
Data:

Data Item Data Definition Sample Values
Date of this Current Date 9/30/2001
Report
Connections Date of Latest OCFS Data Warehouse Update 9/27/2001
Data As Of
Statewide Geographical location where the allegations Upstate

occurred
Total CPS The total number of CPS Reports that were active
Reports Active at any time during the period covered.
This Period
Total CPS The total number of CPS Reports active as of
Reports Active midnight on the first day of the period covered.

at Beginning of
Period

Total CPS
Reports Active
at End of Period

The total number of CPS Reports that were active
as of midnight on the last day of the period
covered.

Total New CPS
Reports
Assigned This
Period

The total number of CPS Reports assigned to a
worker during the period requested.

(Table continued on next page)




Data Item

Data Definition

(Table continued from previous page)

Sample Values

Total Initial CPS
Reports
Assigned This
Period

A subset of Total New CPS Reports Assigned This
Period, reflecting the number of new Initial CPS
Reports assigned during the period.

Total
Subsequent CPS
Reports
Assigned This
Period

A subset of Total New CPS Reports Assigned This
Period reflecting the number of new Subsequent
CPS Reports assigned during the period.

Total CPS
Reports Overdue
on Last Day of
Period

The total number of CPS Reports that were still
active at the end of the period and the number of
days between the intake start date and the period
end date is greater than 60 days.

Total CPS A subset of the Total CPS Reports Closed This
Reports Period that were determined as Indicated.
Indicated

Total CPS A subset of the Total CPS Reports Closed This
Reports Period that were determined as Unfounded.
Unfounded

Total Closed The number of CPS Reports that were closed on
CPS Reports the Connections system but remained opened for
Opened for services.

Services This
Period




How To Save A Data Warehouse Report

After you have run a Data Warehouse report, you will have the option of printing, saving
or closing the report. The following steps will take you through the save process.

Steps to Saving a Report:

1.

11.

12.
13.

14.

15.
16.

While in the Report, click on File from the Menu.

. From the File Menu, click on Save As. This will open a Save As Window.

Click on the dropdown box labeled “Save in:” to select “My Home Drive
(T:).

Double click on the T: drive to open.

The Save In: dropdown allows you to choose the folder you wish to save your
document in.

Select OCFS Data Warehouse for all Cognos reports.

Enter a File name for your report.

Click on the dropdown list for ‘Save as type’ and, if you intend to print this
document at a later time, select either of the following types:

Adobe Acrobat (.pdf) or Excel (.xls)

. Both of the above document types are conducive to printing the report at a

later time.

If you intend to rerun the report at a later date (e.g., weekly or monthly

reports) you should save it in:

o Impromptu Query (.imr) format (within Impromptu) or Power Play (.ppr)
format (within Power Play).

Once all required areas are completed, click the Save Button.

After you have created all necessary reports and have saved them you can

now exit from CITRIX.

When using Impromptu, you must close out the current catalog before closing

out of the Data Warehouse. On the Menu, select Catalog; then Close. This

will close the report.

To return to the CITRIX desktop, click on File = Exit .

To close out of the application, click on the Start Menu and choose Log Off

(user name).

** YOU SHOULD NEVER CLOSE OUT THE WINDOW BY CLICKING
ON THE “X” LOCATED AT THE UPPER RIGHT HAND CORNER OF
THE WINDOW AS THIS MAY RESULT IN LOSS OF ALL
REPORTING THAT WAS DONE DURING THAT SESSION.



Open and Print a Saved Report From the T Drive

If you have saved a report for printing (i.e., Excel, PDF, or HTML) to your T: drive, you
can print the report from your local desktop. Do not print in the Citrix environment.

1. To open a saved report from vour regular desktop

a. From regular desktop, open MY COMPUTER by double clicking on it. This
will open all available DRIVES.

b. Double click on the T: drive.

2. To print:

a. Double click on the OCFS Data Warehouse folder. Then double click on
the report that you want to open.

b. The report may take a few minutes to open depending on the SIZE of the
FILE. On the bottom of the .PDF file is the Number of Pages for that report.
If you print the entire report, this is the number of pages that will be printed.
Please note that a large report may tie up the printer.

c. To help alleviate this problem, you can print only selected pages. From the
Menu bar, click on File 2 Print.

d. The next screen will ask you the pages to be printed starting at page number ?
and ending at page number ?. You need to put in the page numbers that you
want to print and you can change the printer that you want to print to.
Otherwise, it will go to your default printer. When complete, click OK to
print.

e. You can preview the pages before deciding which ones to print by clicking on
the Arrows located at the bottom left hand side of the window.

f. The same procedure, in terms of choosing specific pages to print, is also
followed when printing an Excel document.

g. This will open the same print window as when printing a document with
Adobe Acrobat. When the Printer and Print Range have been selected, click
on OK to print.

h. Close report by clicking on File > Exit.



To Copy and Paste Reports to the Local Machine

In order to copy reports from the T: drive to your C: drive, you must first provide a
location on the C: drive for these reports. Create a new folder on the C: drive and name it
OCFS Data warehouse Reports.

1. You will then need to access the T: drive to get the report(s) you will be copying
FROM. Open the OCFS Data Warehouse Folder to display the reports.

2. Highlight the report that you want to copy and click on the Edit Menu bar and
then choose Copy.

3. Once COPY has been selected, access your C: Drive and open the OCFS Data
Warehouse Reports folder.

4. Place your cursor anywhere within the blank space of this folder and then select
the Edit Menu bar and choose Paste.

5. When the copying is complete, double click on the document to open. You will
then be able to print using your normal print functions.





